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7. Asociar acciones a los items del menú 21
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1. Introducci ón

La idea de este guión es que el alumno aprenda por sı́ sólo las princi-
pales utilidades que proporciona Netbeans para construir el interfaz gráfi-
co de una aplicación J2SDK. Nosotros utilizaremos la versión 5.5 de Net-
beans . Esto nos facilitará enormemente la tarea de construir la aplicación
Java, sobre todo en cuanto al interfaz gráfico.

Este guión muestra como construir un programa completo (una ver-
sión simple del juego del Tetris) usando Netbeans 5.5 . El interfaz gráfico
será desarrollado de forma visual con Netbeans.

1.1. Creaci ón del proyecto

Crea un proyecto para la nueva aplicación:

1. Selecciona Menú File → New Project (Ctrl + Shift + N) , o bien
pulsa en el icono New Project de la barra de utilidades del IDE.

2. Seleccionamos General → Java Application y pulsa el botón Next .

5



Nuevas Tecnologı́as de la Programación Construcción del juego del tetris con
Netbeans 5.5 6

3. Como nombre del proyecto introducimos TetrisSwing5.5. Como
carpeta (directorio) donde colocar el proyecto usaremos el directorio
ProjectsNB\TetrisSwing5.5. La carpeta ProjectsNB debe
estar previamente creada dentro de tu home. Para ayudarte a selec-
cionar esta carpeta puedes pinchar en el botón Browse .

4. Asegúrate que está seleccionada la opción Set as Main Project y no
seleccionada la opción Create Main Class.

5. Pulsa el botón Finish .

1.2. Creaci ón del contenedor de objetos

Crearemos un contenedor JFrame y lo colocaremos en un nuevo pa-
quete.

1. Pinchar con el botón derecho del ratón sobre el nodo TetrisSwing de
la ventana de proyectos, y elegir New → JFrame Form

2. Introduce TetrisFrame como nombre para el nuevo JFrame. Co-
mo nombre del paquete introduce guitetris.
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3. Pulsa el botón Finish .

El IDE crea el form TetrisFrame y la clase TetrisFrame dentro del fi-
chero TetrisFrame.java. El paquete guitetris sustituye ahora al
paquete <default package>, y el form TetrisFrame se abre en la ven-
tana Editor en la vista de diseño (Design) que muestra una vista gráfica
de los componentes GUI. Además se abre una ventana para la paleta de
componentes en la parte superior derecha del IDE, el inspector de compo-
nentes aparece en la parte izquierda debajo de la ventana de proyectos,
y la ventana de propiedades aparece en la parte derecha debajo de la
paleta de componentes.

Las versiones 5.5 y 5.0 de netbeans utilizan por defecto el nuevo gestor
de posicionamiento GroupLayout que facilita enormemente la tarea de
colocar los componentes en él. Para el JFrame que acabamos de crear
podemos comprobarlo pinchando con el botón derecho del ratón en el no-
do JFrame del inspector de componentes y seleccionar Set Layout en el
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menú contextual. Podemos observar que aparece en negrita Free Design
que corresponde al layout GroupLayout. Podrı́amos seleccionar ahora
otro distinto pero no lo haremos, pues éste layout es el más adecuado.

1.3. Definici ón de la clase principal del proyecto

Debemos ahora definir la clase principal (Main Class) de forma que los
comandos de construcción y ejecución (Build y Run) funcionen de forma
correcta. En este caso lo que queremos es poner como clase principal, la
clase TetrisSwing que hemos creado en los pasos anteriores.

1. En la ventana de proyectos, pincha con el botón derecho en el nodo
del proyecto TetrisSwing5.5 y elige Properties. Aparecerá entonces
el siguiente diálogo:

2. En el panel de categorı́as (Categories) del diálogo de propiedades
del proyecto, selecciona el nodo Run.
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3. En el panel derecho, pincha el botón Browse que está a la izquierda
del campo Main Class.

4. En el diálogo Browse Main Classes que aparece, selecciona guite-
tris.TetrisSwing, y pulsa Select Main Class.

5. Pincha Ok para salir del diálogo de propiedades del proyecto.

2. Construcci ón del menú

Ahora añadiremos una barra de menús a nuestro form.

1. Seleccionar JMenuBar en la solapa Swing de la paleta de compo-
nentes.

2. Pinchar con el ratón en cualquier parte del panel del editor del form.

Inicialmente la barra de menús tendrá sólo un menú, sin ningún item.
Vamos a añadir otro menú, y le pondremos a cada uno sus opciones
(items).

1. Pinchar con el botón derecho del ratón en JMenu1 .
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2. Añadir dos JMenuItem a JMenu1 mediante Add → JMenuItem .

3. Renombrar el JMenu y los JMenuItem, modificando además algu-
nas propiedades según muestra la siguiente tabla:

Nombre original Nuevo nombre Text Tooltip text Mnemonic
jMenu1 FileMenu File File F
jMenuItem1 NewItem New New N
jMenuItem2 ExitItem Exit Exit X

3. Creaci ón del panel de juego

A continuación crearemos una clase que herede de JPanel que nos
servirá para mostrar el panel de juego. Este nueva clase sobreescribirá el
método paintComponent(Graphics g) para que se encargue de di-
bujar el panel de juego con las figuras incluidas. Para ello realiza los si-
guientes pasos:

1. Selecciona el nodo TetrisSwing en la ventana de proyectos, y crea
un nuevo JPanel : Menú File → New File → Java GUI Forms →
JPanel Form .

2. Nombraremos RejillaPanel a esta nueva clase y la incluiremos en el
paquete guitetris.
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3. Modifica la propiedad preferredSize de RejillaPanel para que ten-
ga los valores [200,400]: Selecciona el nodo [JPanel] del form
RejillaPanel en el inspector de componentes y modifica la propiedad
en la ventana de propiedades.

4. Incluye el dato miembro private TetrisFrame frame en la clase Rejilla-
Panel. Esta variable referencia será utilizada para poder acceder al
TetrisFrame donde será incluido este JPanel y ası́ poder acce-
der a algunos métodos de tal clase que necesitaremos utilizar desde
esta clase.

5. Añade un nuevo constructor a la clase RejillaPanel que tenga un
parámetro de la clase TetrisFrame. El constructor utilizará este paráme-
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tro para inicializar el dato miembro introducido en el paso anterior
(frame). El constructor debe quedar como sigue:

public RejillaPanel(TetrisFrame fr) {
this();
frame = fr;

}

6. Compila la clase RejillaPanel. Este paso es muy importante, ya
que de no hacerlo el siguiente paso no se podrá hacer.

7. Añade el panel RejillaPanel como componente del JFrame de
TetrisFrame. Para ello realiza los siguientes pasos:

Abre nodos del form TetrisFrame en el inspector de componen-
tes hasta que sea visible el nodo [JFrame].

Copia RejillaPanel al portapapeles (con el botón derecho
del ratón pincha el nodo RejillaPanel de la ventana de pro-
yectos y selecciona Copy en el menú contextual).

Pega el panel en el JFrame: Pincha con el botón derecho del
ratón el nodo [JFrame] de TetrisFrame en el inspector de
componentes, y selecciona Paste en el menú contextual. Este
paso hará que se añada al JFrame de TetrisFrame un RejillaPanel
llamado rejillaPanel1.

8. Cambiemos el código generado automáticamente por netbeans pa-
ra construir el objeto rejillaPanel1 para que haga uso del nuevo
constructor que hemos incluido anteriormente (RejillaPanel(TetrisFrame)).

a) En el inspector de componentes selecciona el componente rejillaPanel1.

b) Pincha el botón Code que hay en la parte derecha de la ventana
de propiedades.
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c) Pincharemos en el botón etiquetado con ... de la propiedad
Custom Creation Code. Aparecerá el siguiente diálogo:

Incluye la siguiente lı́nea de código y pulsa Ok.

new RejillaPanel(this);

Visualiza el código fuente de TetrisFrame, y comprueba co-
mo ahora el componente rejillaPanel1 se crea con:

rejillaPanel1 = new RejillaPanel(this);

4. Pintar el tablero de juego en el JPanel

En esta sección incluiremos el código necesario para que aparezca
dibujado el tablero de juego. Para ello realiza los siguientes pasos:

Crea un nuevo paquete en el proyecto llamado data.

Copia los ficheros Rejilla.java, Figura.java y Elemento.java
que puedes encontrar en http://decsai.ugr.es/~acu/NTP/
archivos/Guion5 en el directorio src/data de tu proyecto usando
el sistema de ficheros. La clase Rejilla es básicamente una clase que
contiene una matriz bidimensional donde cada celda puede contener
los valores VACIA, BLOQUE o PIEZA. La clase Figura representa la
figura que cae actualmente en el juego. La clase Elemento es utili-
zada por la clase Figura y representa una de las celdas ocupadas
por la Figura.
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Añade el dato miembro private int anchoCelda a la clase RejillaPa-
nel. Esta variable representa el número de pixeles que ocupa cada
celda de la Rejilla cuando se dibuje en el JPanel de RejillaPanel. La
variable anchoCelda se inicializa con −1. Más adelante introducire-
mos código en el método paintComponent(Graphics g) para calcular
su valor correcto que se adapte al tamaño que tenga el JPanel.

/**
* Referencia al TetrisFrame donde se incluye este JPanel
*/

private TetrisFrame frame;

/**
* Número de pixeles del ancho y alto de cada celda de
* este tablero de juego
*/

private int anchoCelda = -1;

Añade las variables Rejilla rejilla y Figura figura a la clase TetrisFra-
me. Estas variables las utilizaremos para crear una nueva Rejilla y
la Figura actual que cae en el panel de juego. Debes también impor-
tar las clases del paquete data en la clase TetrisFrame para poder
usar las clases de tal paquete ya que TetrisFrame pertenece a un
paquete diferente (guitetris).

package guitetris;
import data.*;

/**
*
* @author acu
*/

public class TetrisFrame extends javax.swing.JFrame {
private Rejilla rejilla;
private Figura figura;

/** Creates new form TetrisFrame */
public TetrisFrame() {

initComponents();
}

Añade al constructor de TetrisFrame el código para que se cree una
nueva Rejilla con tamaño 12 celdas de ancho por 22 de alto:

/** Creates new form TetrisFrame */
public TetrisFrame() {

initComponents();
rejilla = new Rejilla(12,22);

}

Añade los métodos getRejilla() y getFigura() a la clase TetrisFrame.

/**
* Obtiene una referencia a la Rejilla del juego
* @return una referencia a la Rejilla del juego
*/

public Rejilla getRejilla(){
return rejilla;

}

/**
* Obtiene una referencia a la Figura que cae actualmente en el juego
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* @return una referencia a la Figura actual
*/

public Figura getFigura(){
return figura;

}

En la clase RejillaPanel incluye las siguientes sentencias import :

import data.*;
import java.awt.Color;

Añade los métodos dibujaRejilla(Graphics g) y dibujaFigura(Figura
fig,Graphics g) a la clase RejillaPanel.

/**
* Dibuja cada una de las celdas de la matriz bidimensional de la Rejilla.
* Cada celda puede estar ocupada por BLOQUE (muro exterior) o PIEZA
* (elemento de una Figura)
* @param el Graphics donde se dibujar á
*/

public void dibujaRejilla(java.awt.Graphics g){
int i,j;
Rejilla rejilla=frame.getRejilla();

int xoffset=(getWidth()-rejilla.getAnchura()*anchocelda)/2;
for(i=0;i<rejilla.getAnchura();i++){

for(j=0;j<rejilla.getAltura();j++){
if(rejilla.getTipoCelda(i,j) == Rejilla.BLOQUE){

g.setColor(Color.BLACK);
g.drawRect(xoffset+i*anchocelda,j*anchocelda,anchocelda,

anchocelda);
} else if(rejilla.getTipoCelda(i,j) == Rejilla.PIEZA){

g.setColor(Color.YELLOW);
g.fillRect(xoffset+i*anchocelda,j*anchocelda,anchocelda,

anchocelda);
g.setColor(Color.RED);
g.drawRect(xoffset+i*anchocelda,j*anchocelda,anchocelda,

anchocelda);
}

}
}

}

/**
* Dibuja la Figura fig en el Graphics g pasado como par ámetro
* (normalmente el asociado a este Canvas)
* @param fig la Figura a dibujar
* @param el Graphics donde se dibujar á
*/

void dibujaFigura(Figura fig,java.awt.Graphics g){
if (fig!=null){

Elemento elemento;
Rejilla rejilla=frame.getRejilla();
int xoffset=(getWidth()-rejilla.getAnchura()*anchocelda)/

2+fig.getXOrigen()*anchocelda;
int yoffset=fig.getYOrigen()*anchocelda;
for(int i=0;i<fig.getNElements();i++){

elemento=fig.getElementAt(i);
g.setColor(Color.YELLOW);
g.fillRect(xoffset+elemento.getColumna()*anchocelda,
yoffset+elemento.getFila()*anchocelda,anchocelda,anchocelda);
g.setColor(Color.RED);
g.drawRect(xoffset+elemento.getColumna()*anchocelda,

yoffset+elemento.getFila()*anchocelda,
anchocelda,anchocelda);

}
}

}
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Sobreescribiremos (override) el método paintComponent(Graphics g)
en la clase RejillaPanel :

• Selecciona el fichero RejillaPanel.java en la ventana de proyec-
tos.

• Elige Menú Source → Override Methods .

• En el diálogo que aparece, selecciona el método paintComponent(Graphics g)
de la superclase JComponent. Asegúrate que queda seleccio-
nada la opción Generate Super Calls para que en la versión
sobreescrita de paintComponent(Graphics g) se siga lla-
mando a la versión de la super clase.

• Pulsa el botón Ok.

• El método paintComponent(Graphics g) aparecerá en la
clase RejillaPanel.

16
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Modifica el anterior método paintComponent(Graphics g) de Rejilla-
Panel de la siguiente forma:

protected void paintComponent(java.awt.Graphics g) {
super.paintComponent(g);
if(anchocelda==-1){

anchocelda=Math.min(getWidth()/frame.getRejilla().getAnchura(),
(getHeight()-10)/frame.getRejilla().getAltura());

}
g.setColor(Color.WHITE);
g.fillRect(0,0,getWidth(),getHeight());
dibujaRejilla(g);

}

El anterior código hace que la variable anchocelda se inicialice la
primera vez que se entra en este método, o sea la primera vez que
aparece el RejillaPanel en pantalla. Además se dibuja la Rejilla me-
diante la llamada a dibujaRejilla(g).

Compila y ejecuta el proyecto de nuevo.

Lo único que nos falta es hacer que aparezca la figura en el tablero
de juego, y que ésta vaya cayendo hacia abajo. Esto lo haremos en la
siguiente sección.
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5. Movimiento de la figura del tetris

Para conseguir que una figura se mueva continuamente hacia abajo
hasta que choque contra otra figura o bien contra la parte inferior del ta-
blero, debemos construir una hebra que se encargue de ello.

Añadir los métodos nuevaFigura() e inicializaJuego() a la clase Te-
trisFrame:

/**
* Obtiene una nueva figura cuyo tipo es seleccionado de forma aleatoria
*/

public void nuevaFigura(){
figura = Figura.nuevaFigura();

}

/**
* Deja VACIA todas las celdas de la Rejilla, la inicializa
* de nuevo. Adem ás genera una nueva Figura de tipo aleatorio
*/

public void inicializaJuego(){
rejilla.initRejilla();
nuevaFigura();

}

Añade el método RejillaPanel getPanel() a la clase TetrisFrame:

/**
* Obtiene una referencia al panel donde se dibujan las piezas del juego
* @return una referencia al panel del juego
*/

public RejillaPanel getPanel(){
return rejillaPanel1;

}

Copia el fichero Mueve.java que puedes encontrar en http://
decsai.ugr.es/~acu/NTP/archivos/Guion5 en el directorio
src/data de tu proyecto usando el sistema de ficheros. Esta clase es
la que implementa la hebra que se encarga de mover la pieza que
cae actualmente en el juego.

Después de copiar este fichero, la clase se habrá añadido al paquete
data del proyecto.

Añade el dato miembro private Mueve mueve a la clase TetrisFra-
me y crea con él un objeto de la clase Mueve dentro del constructor
de TetrisFrame. Además, desde el constructor de TetrisFrame, llama
al método nuevaFigura() que creará una nueva Figura de for-
ma aleatoria, y llama a mueve.reanudar() para que comience a
moverse la Figura que acaba de generarse:

/** Creates new form TetrisFrame */
public TetrisFrame() {

initComponents();
rejilla = new Rejilla(12,22);
mueve=new Mueve(this, 2);
nuevaFigura();
mueve.reanudar();

}
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Añade al final del método paintComponent() de la clase Rejilla-
Panel la llamada al método dibujaFigura(frame.getFigura(),g);
para que la figura actual sea visible en el JPanel :

protected void paintComponent(java.awt.Graphics g) {

super.paintComponent(g);
if(anchocelda==-1){

anchocelda=Math.min(getWidth()/frame.getRejilla().getAnchura(),(
getHeight()-10)/frame.getRejilla().getAltura());

}
g.setColor(Color.WHITE);
g.fillRect(0,0,getWidth(),getHeight());
dibujaRejilla(g);
dibujaFigura(frame.getFigura(),g);

}

Ejecuta el proyecto. Puedes comprobar que en el tablero ya aparece
una figura que se va moviendo hacia abajo pero que todavı́a no pue-
de controlarse con las teclas para moverla a izquierda o derecha, o
para rotarla.

6. Movimiento a izquierda y derecha y rotaci ón
de la figura

En esta sección añadiremos el código necesario para que la figura que
cae actualmente se mueva a izquierda y derecha con el teclado (teclas iz-
quierda y derecha). Además utilizaremos la tecla de flecha hacia arriba
para que la figura rote en sentido contrario a las agujas del reloj. La tecla
de flecha hacia abajo se utilizará para que la figura avance más rápida-
mente hacia abajo. Los pasos que hay que realizar son los siguientes:

Controlar el evento keyPressed en la clase RejillaPanel. Pue-
de hacerse seleccionando el nodo JPanel del form RejillaPanel
en el inspector de componentes, seleccionando luego la solapa Events
de la ventana de propiedades del JPanel y pinchando finalmente
en la casilla ¡none¿ del evento keyPressed. Este paso hará que
se añada a la clase RejillaPanel el método:

private void formKeyPressed(java.awt.event.KeyEvent evt) {
// TODO add your handling code here:
}

19
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Controla también el evento mouseEntered en la clase RejillaPanel.
Este paso hará que se añada a la clase RejillaPanel el método:

private void formMouseEntered(java.awt.event.MouseEvent evt) {
// TODO add your handling code here:
}

Incluye en la clase RejillaPanel la sentencia:

import java.awt.event.KeyEvent;

Añade al método formKeyPressed() de RejillaPanel, el siguiente
código para controlar lo que se debe hacer según qué tecla de flecha
se pulse:

private void formKeyPressed(java.awt.event.KeyEvent evt) {
if (evt.getKeyCode() == KeyEvent.VK_LEFT){

if(!frame.getRejilla().seChoca(frame.getFigura(),Figura.IZQUIERDA)){
frame.getFigura().mueve(Figura.IZQUIERDA);
if(frame.getPanel()!=null)

frame.getPanel().repaint();
}

}else if (evt.getKeyCode() == KeyEvent.VK_RIGHT){
if(!frame.getRejilla().seChoca(frame.getFigura(),Figura.DERECHA)){

frame.getFigura().mueve(Figura.DERECHA);
if(frame.getPanel()!=null)

frame.getPanel().repaint();
}

}else if (evt.getKeyCode() == KeyEvent.VK_UP){
frame.getFigura().rotar(frame.getRejilla());
if(frame.getPanel()!=null)

frame.getPanel().repaint();

}else if (evt.getKeyCode() == KeyEvent.VK_DOWN){
if(!frame.getRejilla().seChoca(frame.getFigura(),Figura.ABAJO)){

frame.getFigura().mueve(Figura.ABAJO);
if(frame.getPanel()!=null)

frame.getPanel().repaint();
}

}
}

20
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Añade al método formMouseEnterred() de RejillaPanel, la si-
guiente lı́nea para que cuando el ratón se introduce dentro de Reji-
llaPanel, su JPanel adquiera el foco del teclado y ası́ pueda recibir
los eventos de teclado necesarios para mover la figura del juego:

private void formMouseEntered(java.awt.event.MouseEvent evt) {
requestFocus();

}

Ejecuta el proyecto de nuevo y podrás comprobar que la figura ya
puede moverse con las teclas de flechas del teclado.

7. Asociar acciones a los items del menú

Para terminar vamos a asociar las acciones que se deben ejecutar al
seleccionar alguno de los dos items que tenemos en el menú File:

Abrir el nodo ExitItem en el inspector de componentes: TetrisFrame
→ Form TetrisFrame → [JFrame] → jMenuBar1 → FileMenu →
ExitItem

Pinchar con el botón derecho este nodo y seleccionar en el menú con-
textual Events → Action → actionPerformed . Como resultado se
añade el método ExitItemActionPerformed() al código fuente
de la clase TetrisFrame.

Incluir dentro de este método la sentencia System.exit(0) para
que acabe el programa:

private void ExitItemActionPerformed(java.awt.event.ActionEvent evt) {
System.exit(0);

}

De igual forma asocia una acción al item NewItem incluyendo el si-
guiente código:

private void NewItemActionPerformed(java.awt.event.ActionEvent evt) {
inicializaJuego();
mueve.reanudar();

}

8. Posibles mejoras del juego

Algunas posibilidades de amplicación del juego que se dejan como
ejercicio son las siguientes:

Permitir que el juego sea detenido al pulsar una determinada tecla,
como por ejemplo la barra espaciadora.

Hacer que se visualice la siguiente Figura que va a aparecer.
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Que cada tipo de Figura aparezca en un color diferente.

Mostrar el tiempo que ha pasado desde que se comenzó el juego.

Hacer uso de niveles. Se podrı́a hacer que cuando se completen 20
lı́neas se pasarı́a a un nivel superior en el que las piezas caen a una
mayor velocidad. Esto es relativamente sencillo pues el constructor
de la clase Mueve ya está preparado para pasarle un parámentro
que indica el nivel.

Contar los puntos conseguidos. Por ejemplo 5 puntos por lı́nea.

9. Localizaci ón del programa ya terminado

El proyecto del programa ya terminado puede encontrarse en http:
//decsai.ugr.es/~acu/NTP/archivos/Guion5/programaguion3java.
tgz
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